Welcome to Mac OS X



Welcome to Mac OS X,
the world’s most advanced
operating system.

This book helps you start
using Mac OS X.

First install the software,
then discover how easy

it is to use.
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Installing
Mac OS X

Step 1: Upgrade to Mac OS 9.2 (skip if it’s already installed)
Use the Mac OS 9.2 CD included with Mac OS X.

,/ & '.‘ \ A If your computer came with Mac OS 9.2 installed
‘.‘ ’ and you need to reinstall, use the CD that came
with your computer.

Although Mac OS 9.2 is recommended, it isn’t required. To use Classic Mac OS 9 applications, you
must have Mac OS 9.1 or later installed.

Step 2: Get setup information (skip if upgrading Mac OS X)

You'll need your iTools member name and password and the settings from these Mac OS 9
control panels:

Settings In Mac OS 9

TCP/IP TCP/IP control panel

Internet and mail Internet control panel

Dial-up connection (PPP) Remote Access and Modem control panels

You can also find your settings in your email and Web browser applications or you can get them
from your Internet service provider (ISP) or system administrator.

Step 3: Decide where to install (skip if upgrading Mac OS X)

You can install Mac OS X on the same disk or disk partition as Mac OS 9.

B 9 A Do not select the checkbox

to format the disk.
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You can also install Mac OS X on a different disk or disk partition from Mac OS 9. For more
information, see “Advice” at the end of this book.



Step 4: Insert the Mac OS X CD, then double-click Install Mac OS X

¥

. k4
LY/
In Mac OS 9 In Mac OS X

Step 5: Set up and register

When you set up Mac OS X, you create a user account. This user account is an administrator. An
administrator has greater access to the computer. For example, an administrator can add user
accounts and install software in the Applications folder on the Mac OS X disk.

If you set up Mac OS X for several users, you need to type a user name and password to gain
access or “log in” to your computer. To administer your computer, you log in as the user you
created when you set up Mac OS X so remember this user name and password.

Create Your Account

With Mac OS X, everyone wha uses the computer can have an account with
their own settings and a place to keep their documents,

Set up your account now. You can add accounts for others later.

MName:

Lxampie: Mary Jores

Short Hame

— Type this name and password
exactly the same way when
you log in.

Password,

Verify:

Password Hint
tuptinnal

Goback ) ( Continue

X/
\\X? Installation tips

Why you need Mac OS 9 installed

Mac OS X provides Classic so you can use your

Mac OS 9 applications. When you open a Classic
application, Classic starts using an available Mac
OS 9.1 or later system.

Read before you install

Be sure to open the READ BEFORE YOU INSTALL
document on the Mac OS X CD. You can open this
document using Acrobat™ Reader or the Preview
application included with Mac OS X.

If you have trouble

If you have trouble installing Mac OS X, setting it
up, or logging in, see “Advice” at the end of this
book. You will also find information about
upgrading Mac OS X.

Starting up in Mac OS 9 again

See “Advice” to learn how to start up
in Mac OS 9 after you start up in Mac OS X.

Installing developer software

Your copy of Mac OS X may include the Developer
Tools CD for developing Mac OS X applications.
Only install this software if you want to develop
Mac OS X applications. For more information, see
“About Developer Tools” on the CD.

Getting more information

For more information about Mac OS X, visit the
Mac OS X Web site:

www.apple.com/macos



Aqgqua makes using your Mac easier than ever. Its color, depth, and
motion guide you through your tasks, while the Finder and Dock provide

easy access to your computer and network.

Aqua

Use the Apple menu to change settings, The Finder shows document icons in

get Mac OS X software, open recent items, several ways, including large, detailed

and restart or shut down your computer. icons that preview document contents.
(B3 Preview File Edit Display Window Help ) o = 11:23 AM

Abaout This Mac
Get Mac 05 X Software...

Dock

System Preferences... i
Location

Recent [tems
K Library & m=m ;- =
Force Quit.. o ueer— [ '
(5 My Music
Sleep s v
Restart

oo % ‘

orrest Leaves

View i iDisk  Computer| Heme Audio CD

% Untitled

- Apple Displays

_! Documents = =

|Sheets for saving and printing |The Dock keeps handy your disks, folders,
attach to windows, making these applications, documents, minimized windows,
tasks even simpler. links to Web sites, and just about anything else.



Your home

When you first start Mac OS X, the Finder window shows your “home,” your personal space on
your computer for documents, applications, fonts, and other software. If you set up several users,
each user has a home.

86eé 4 jandoe =3
.ﬁzmg ‘!'ﬁ_“d ,A‘

Back View i iDisk Computer Home Favorites Applications
L

i ] i

Desktop Documents Library

Click Home to see
your personal space.

] é = Folders in your home help you
organize your documents,
pictures, and movies.
“Public  Sites
Buttons

Colorful, animated buttons make it clear what to do.

If a button pulses, you can
press the Enter or Return
key instead of clicking it.

f save N

Here’s how to use the three window buttons:

Click to close Click to minimize the
the window. window, which puts it in
L the Dock.

é f———Click to enlarge or reduce

the window.

Mac OS user

() For the experienced
\\_‘.

What is my “home”?

As with Mac OS 9, you can keep your documents
just about anywhere, but your home provides a
secure place to keep them if your computer is on
a network or several users use it.

X Mac OS X tips

Getting help

To get answers to your questions, choose Help
from the Help menu, type your question,

and click Ask. Then click an answer.

8ee Mag Help
" Ask
I—Type your
— question
‘_ Mac H@lp here, then
click Ask.

Quick Clicks What's new?
W1 di | wse 1he

”"{?\\\ Searching Mac Help
‘Q, How do I use Help?



The Dock makes it easy to open applications, documents, and

other items you use frequently. To open an item, click its icon.

Flowers >
¢ Large flower
¥ Large leaves

Proposal Press a folder
This side of the Drag this bar — P icon to see its
Dock shows up or down to 4 Stream contents and

|application icons. resize the Dock.

open items in it.

| Show In Finder

| = — i owh L
epr:i“ ‘ ¥ (24 § S
PDF — t“% e =

The 'triangleT The icon shows |This side of the Dock
indicates the the status of the

shows everything else.
application application.
is open.




What’s in the Dock

Finder

Click to see a Finder window and menus. Press the icon to see open Finder windows

in a pop-up menu. Choose one to bring it to the front.

Mail

An application included in the Dock. The number shows your unread messages.

Document

A document you've added to the Dock. Click to open it.

Folder

Press the icon to see the folder’s contents. Then choose an item from the
pop-up menu.

Web site

A Web site added to the Dock. Click to open the Web site in your browser.

Minimized window

You can put any window in the Dock. Click to open the window.

Trash

Drag files here to throw them away. Drag the icon of a disk here to eject the disk.

) For the experienced
/ Mac OS user
What’s the Dock for?

Keep items in the Dock for quick access. Instead
of using the Application menu, click items in the
Dock to make them active. Instead of the Control
Strip, use the Dock to change settings and see the
status of applications.

Opening a document

Drag the document’s icon to the application’s
icon in the Dock.

X Mac OS X tips

Adding icons to the Dock

To add an item to the Dock, drag its icon to the
Dock. To remove an item, drag its icon from the
Dock. (This does not change the item.)

Adding disk icons to the Dock

Add a disk icon to the Dock, then press it to see
the disk’s contents. Choose an item from the pop-
up menu to open it.

Changing the Dock

To change the way the Dock looks and works,
choose Dock from the Apple menu, then choose
Dock Preferences.

Switching between open applications

Press the Command (g) key, then press the Tab
key until you select the open application you want
to use. Then release the keys.

<

‘ ",7’“ Searching Mac Help
¥4 How do I use the Dock?



The Finder is the gateway to your computer, network, and Internet.
Use the Finder to access disks, connect to servers, see your iDisk,

and open documents.

The Use the Finder Click toolbar buttons Click here to

H application menu to open your home show or hide
Fl n e r to set preferences. and other places. the toolbar.

[ & BELES File Edit View Go  Window Help 4 | = 11:23 AM
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Preferences .. YT Pictures
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Hide Finder
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Show All
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Dresktan Documents Library

=

Pictures

§ -
FireWire Disk

Press here to choose |Your home contains your documents.
hidden toolbar items. Turn on file sharing in Sharing preferences

to let others access your Public folder.



How your Mac OS X disk is organized

8686 1 Hard Disk —  The Applications folder contains the Mac OS X
- =T A G | (g\ /A applications available to all users of your computer.
Back—— View Bum  Disk  Computer Home  Appications Library contains fonts, plug-ins, Internet search sites,
and other items available to all users of your
A j m computer.
A;p;lmm S i Users contains your home and the home of other user
) accounts. Use the Shared folder in Users to share
documents with other users.
£ ‘ System contains the Mac OS X software. You cannot
x v change it.
ystem sers

You'll see Applications (Mac OS 9) and System
Folder if Mac OS X is installed on the same disk
as Mac OS 9.

If you set up several users for your computer, log in as an administrator, such as the one you
created when you set up Mac OS X; to add items to the Applications and Library folders.

Finder views

You can view Finder windows in icon, list, or column view. Column view lets you quickly see where
items are located.

Click here to change the view.

ece L LT =
= ssgmip‘A !;"‘ - R —/A

w ; L8]
Back View i Bum  iDisk Computer Home Applications
[ Desktop & At the Beach
Documents & Kids . . .
# Library S PowerBook G4 Preview movies, pictures,
. mms & Snow Trip even text. If it's a movie,
& usic .
| Pictures you can play it.
& Public
Sites ,.:,, ,“,I’,
Name: PowerBook G4
Kind- OuitckTime Mavie This area shows information
Size: 484 KB 5
Created: 7/14/01 about the item.
Modified: 7/14/01
Dimensions: 422 x 292
Duration: 00'02
: D>
Click a folder to

Drag here to resize

see its contents. the columns.

For the experienced
Mac OS user

Using Library folders

Put fonts, Internet plug-ins, and other items in the
Library folder. Items in the main Library folder are
available to all users. Keep items for your personal
use in the Library folder in your home.

Opening recent items

To open recent applications and documents,
choose Recent Items from the Apple menu. To
open recent folders, use the Go menu. You can
also open recent items using the pop-up menu in
the Open, Save, and Connect To Server dialogs.

\\( )
X Mac OS X tips
Opening folders

If the toolbar is showing when you double-click a
folder, the folder opens in the same window. If the
toolbar is hidden or you press the Command key
when you double-click, the folder opens in a
separate window.

Opening another Finder window

To open another Finder window, choose New
Finder Window from the File menu.

Finding anything on your computer
To find anything on your computer, choose Find
from the File menu to open Sherlock.

Using Favorites

To add an item to your Favorites, select it and
choose Add To Favorites from the File menu.

«

"7“ Searching Mac Help
b How is my hard disk organized?



Customization

10

In Mac OS X, you can customize the Finder and other applications in

many different ways so that they look and work best for you.

Place the Dock on
the side, using
Dock preferences.

Applications

may also

have toolbars that you
can customize.

Change the Finder

toolbar to make it look

the way you want it.

Check the status
of some items in
the menu bar.

@& Finder File Edit View Go

Window Help

4 ¢ = 11:23 AM

=
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10 Jan Doe
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7 Apple iCards

o

This iCard has been sentio you fram Bill James

BNE

==

& Think different

If ™,
Subject Dare & Tima v \
Cot your message Today at 03:46FM i
Friday Today at 04:35FM |
Re: And Another Thing Today at 09:44FK
That info you wanted... Today at 05:43FK
Big News! Today at 06:42FM f
Eill Jarmes fas sent you ar Apple iCard Today at 06:52FM v '
808 |i= Plctures =1
cemeo S0 B 4 ¢ A W é
Bark iy Bum IDIsk  Comguter  Home Favortes  Applications  Mowies  Music
_——
Forest

To select a background

picture, open System
Preferences and click Desktop.

To use a picture or color for the background

of a folder window, choose Show View
Options from the View menu in the Finder.



Changing the Finder window toolbar

To set up the toolbar the way you want it, choose Customize Toolbar from the View menu.

8eoe B = computer =
e 0 @ M 4 9 A

Back View Bun  iDisk Computer Home Favorites Applications

Drag your favarite items to the toolbar.

- =W (n=m B r'e) ~e
Back Path View Eject Burn CD Customize Separator
= = ] 2
| © @ | = 4 @

New Folder Delete Connect Find Computer Home iDisk

v A 3 B ) = & These buttons open folders
Favorites  Applications Documents Movies Music Pictures Public in your home.
...or choose the default set.
fag = (<) A o .
bl 22, 5 ! it ¥ /‘ér Drag this group to the toolbar
Back View iDisk Computer Home Favorites Applications

to use the default toolbar again.

€ Dene >———Click this when you're finished.

Show | lcon & Text 3]

Choose how to display
the toolbar here.

Here are some other things you can do to customize the toolbar:

= To add a disk, server, or folder to the toolbar, drag its icon from a Finder window or the desktop
to the toolbar.

= Drag items in the toolbar to arrange them.

= To remove an item, drag it from the toolbar,

\ For the experienced
"/ Mac OS user
Changing appearance settings

To change the colors used by Mac OS X and the
highlight color, open the General preferences pane.
To select your own color, choose Other.

Changing the size of icons

To change the size of icons in icon view, open the
View Options window and drag the slider.

7 T

\\ Mac OS X tips
VA

Changing global view options

You can set “global” view options, which apply to
all Finder windows that are set to use these
options. To change these options, choose Show
View Options from the View menu and click Global.

Changing view options for a window

To set view options for a single window, choose
Show View Options from the View menu, and click
“This window only.”

Seeing the path to a folder

Add the Path pop-up menu to the toolbar to see

the folders that contain the current folder. You can
also press the Command key and click the name
of the folder in the window title bar.

Using menu bar icons

Use menu bar icons to check the status of your
modem or AirPort connection, see your battery
state, change the system volume, or see the date
and time.

'/'9“ Searching Mac Help
‘\\, How do I use Finder windows?
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Here are some of the specially designed applications included with

Mac OS X that you will use most frequently.

Finder

Open applications and documents, connect to servers, and access disks.

Microsoft Internet Explorer 5.1

Browse the Web, track your online auctions, and collect Web pages.

Mail

Send and receive email including messages with pictures and movies.

Sherlock

Find what you're looking for on your disks, your network, or the Internet.

System Preferences

Change computer settings such as Internet preferences.

QuickTime Player

Play movies, view pictures, listen to music, and watch QuickTime TV.




More applications

Here are some other applications you'll find in the Applications folder.

oY

L =)
i [l

AirPort SetUp Assistant

Set up your AirPort Base Station and network.

Internet Connect

Use Internet Connect or menu bar icons to connect using a modem or AirPort.

Address Book

Keep all your email addresses and other information about people in one place.

Preview

Open PDF and graphics documents. Save documents in PDF format.

TextEdit

Create documents with formatted text and pictures.

Disk Utility

Erase disks, test and repair disks, and partition disks.

Built for Mac OS X

Bl for Mo O X

Look for this symbol to
purchase software specially
designed for Mac OS X.

) For the experienced
/ Mac OS user

Using the Applications folder

Applications in the Applications folder are available
to all users of your computer. Keep applications for
your personal use in your home.

Installing applications

If you set up several users, you must log in as

an administrator to install software in the
Applications or Library folder. The user you created
when you set up Mac OS X is an administrator.

The application menus

Each application has an application menu next to
the Apple menu that contains commands such as
Preferences and Quit.

N .
Z2\<Mac OS X tips

Updating your software

To update your Mac OS X software, open System
Preferences and click Software Update.

Checking iDisk for new software

Check the Software folder on your iDisk for new
Apple applications, updates to applications, and
demonstrations from other developers.

Forcing an application to quit

If you can’t quit an application, choose Force
Quit from the Apple menu. You can also press
the Option key and the application’s icon in the
Dock, then choose Force Quit.

‘ %“ Searching Mac Help
‘\\',/ How do I use my applications?
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Digital Hub

Mac OS X provides powerful, easy-to-use applications that help you
use your digital devices to create movies, photo albums, music CDs,

and more.

Connect
without wires.

Make your own
digital movies.

Store
your files
on the
Internet.

Rip MP3s.

J \ .
m—— ; urn your
J 8

own CDs.
Watch movies B @ Capture pictures, then

on DVD. publish them on the Web.



Digital Hub applications

iTunes for Mac OS X

Listen to Internet Radio or audio CDs. Save your favorite songs on your hard disk or
MP3 player. If your computer has a CD-RW drive, burn your own music CDs.

iMovie for Mac OS X

Make your own movies with effects, transitions, and a sound track. Use them on your
iTools Web site created with HomePage or send them on CDs.

Apple DVD Player

Watch your favorite movies on DVD. Change languages or see captions. Explore the
extra features of DVD movies.

iDVD 2 for Mac OS X

Create your own Hollywood-style DVDs featuring your favorite iMovies and digital
photos. If your computer has a SuperDrive, burn a disc for viewing in almost any
DVD player.

Image Capture

Download pictures from your digital camera, then automatically prepare them to
publish on the Web.

Burn CD

If your computer has a CD-RW drive, you can burn your own CDs. Just insert a blank
CD, drag the files to the CD’s window, then click the Burn CD icon in a Finder window
toolbar.

() For the experienced
/ Mac OS user

Burning CDs

To burn CDs in the Finder, choose Burn CD from
the File menu or click the Burn CD icon in a Finder
window toolbar.

iTunes libraries and playlists

Each user of your computer has a personal music
library and set of play lists.

_ Mac OS X tips
Controlling iTunes

Press the iTunes icon in the Dock to control
playing music.

Getting free music

Check the Music folder on your iDisk for libraries of
music that you can use with iMovie or iTunes.

Adding effects to an iMovie

You can add as many effects to a clip as you want.
After you add an effect, click Apply then click
Commit before you add another effect.

Keeping a clip in the shelf

To keep the original clip in the iMovie shelf, hold
down the Option key when you drag a clip from
the shelf.

Pasting frames over frames

You can copy a range of frames, then paste them
over another range of frames in iMovie.

-

'9“ Searching Mac Help
¥.°4 How doIbum a cD?
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Mac OS X includes Classic so you can continue to use your Mac OS 9
applications. To use a Classic application, just double-click it. Classic

starts automatically.

CIaSS IC Commands, such as Quit

and Preferences, remain in Windows and dialogs have the
the Classic menus. Classic Mac OS appearance.

& File Edit Font Size Style Sound Help | 4% SimpleText

Power Mac G4.mov Ei

Hard Disk
Applications [Mac 05 9)

n= A . - ..\_ ) c

View i iDisk  Computer Home Favorires  Applications

o T Audio €O
» [ Apple Extras Today, 830 AM
B |7 AppleCD Audio Player £ Yesterday, 2:33 PM
¥ Craphing Calculatar Mon, May 7. 2001, 12:C
B Internet Explorer ——————— Usiing Classic Applications
| Internat Utilities
Netscape Communicatar™ Falder ‘
E Network Browser

[ Outlook Express 5.02 Folder Using Classic Applications
4 OulckTime

[ security Cenlirnee 16 Uge your Classic Mac 05 9 applications.

# Sherlock 2 with Mac OF . Just doubla-click an application or documsnt.
8 simpleText
0 utitities

While Classic starts, a Classic icon
appears in the Dock. The icon
disappears when Classic is ready.
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Starting Classic applications

You can use Classic preferences to start Classic or have Classic start automatically when
Mac OS X starts. If Mac OS 9.1 or later is installed on more than one disk, you can select which

one Classic uses.

e 6 Classic
< HAQ O
showAll - Displays Sound Network Startup Disk
Start/top | Advanced |

Classic is an environment for running Mac OS 9 applications. It starts
automatically when a Classic application is launched, or it can be started here.

Classic is not running

Select a startup volume for Classic:

Hard Disk l’ Start up Classic on login to this computer

[ Hide Classic while starting up

—

——
Start Click Start to start the Classic

Select this checkbox to start Classic
automatically when Mac OS X starts.

Click here to start Classic
immediately.

Finding your Classic software and documents

Your Classic applications and documents are in the same folders they were in before you installed

Mac OS X, such as the Applications (Mac OS 9) folder.

\ For the experienced
/' Mac OS user
Classic requires Mac OS 9.1 or later

To use Classic you must have Mac OS 9.1 or
later installed. If you have an earlier version, use
the Mac OS 9.2 CD included with Mac OS X
to upgrade.

Setting memory for a Classic application

To set the memory used by a Classic application,
choose Show Info from the File menu, then choose
Memory from the Show pop-up menu.

Printing from Classic applications

To print from a Classic application, select a printer
the same way you do in Mac OS 9. For example,
make the Classic application active and choose
Chooser from the Apple menu.

_( 7
X Mac OS X tips

Forcing Classic applications to quit

If you can’t quit a Classic application, choose
Force Quit from the Apple menu. Select the
application and click Force Quit.

Restarting Classic

If you need to restart Classic, click Restart in the
Classic preferences pane. You will be able to save
changes to documents before Classic restarts.

Forcing Classic to quit

In some cases you may need to force Classic to
quit. Open the Classic preferences pane and click
Force Quit. This also quits Classic applications
without saving changes to your documents.

<

‘ ",')“ Searching Mac Help

¥_°,  How do I use Classic
applications?
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Mac OS X lets several people use the same computer, keeping each
user’s documents and software secure. To set up your computer for

several people, create user accounts and require users to log in.

Use the Users pane of
System Preferences to Each user has access
create user accounts.| to the Shared folder.|

<) | = 11:23 AM

@ System Prefs FEdit  View Window Help

;i':. {__:_ Q_a lmg- r HE&

Show All Displays  Sound MNetwork  Startup Disk

MName Klnd
Jan Doe Admin  Mewlser.

Joy Smith
Mew Lser

"Id!'nt'ltf f Password |

Audie CD
P st —
Edit User...

T —
{_ Delete User...

Mamg
Exampie: Mary jones

Short Name:
Exampis. mianas (8 characiars or fawsr,
Ieswurcasw, nes spaess). Used fe FIF, ate

. - = T
Legin Picture: M { Cheoose... : - 4 Users
LB D

Drag piture, select below o thoose a pitture fie... ] T
il 2 v i IDisk  Computer Home Faverltes

PRI gl

la e

v

tormclark Shared

Select a picture to Each user has a home. Finder, Dock, iTools,
appear next to the Mail, and other preferences for each user are
user’s name. kept in the user’s home.



Requiring users to log in

To require users to enter their user name and password to log in, you must turn off automatic
login. You can do so when you create a new user or use the Login Window preferences pane.

ee Login =
i EH A & =
i NG 2

Show All © Displays Sound Network Startup Disk

7Lngin Items | Login Window

ki"Aumr‘r\aﬂca\\\,r log in

To require users to log in,
click to deselect this option.
Name

Password: T Set

Display Login Window as: @ Name and password entry fields
? List of users with accounts on this computer

Select this to see a list of
users when you log in.

(71 Show "Other User" in list for network users

(7] Disable Restart and Shut Down buttons

fshuw password hint after 3 attempts to enter a password
A hint can be created in the Password pane

; Click the lock to prevent further changes

If you turn off automatic login, you see the login window when you start up your computer.

Mac OSX

r Computer

Select your name to log in

m ill Click to select your name,
— then type your password.

o
q (0} (@—Click Log In to type your

name and password.

Restart  Shut Down Log In

If you don’t use the list, type a user name and password, then click Log In.

Mac OS user

() For the experienced
\\_‘.

Multiple users

As with Multiple Users in Mac OS 9, you can
require users to log in. Users who are not
administrators have restricted access.

X7
\V
)\7 Mac OS X tips
L N
Administrator users

The user you created when you set up Mac OS X
is an administrator. An administrator can create
other users, change settings, and install software in
the Applications and Library folders. You can
create more than one administrator.

Keeping your computer secure

Because an administrator has greater access to
the computer, you may want to log in as a user
who isn’t an administrator. If you log in as an
administrator, use the Activation pane in Screen
Saver preferences to require a password if you
leave your computer unattended.

Logging in from a Mac OS X network

If you use a Mac OS X network, your home is on a
server. Log in from any computer on the network
to see your home and use your settings. If you
have questions, see your system administrator.

Setting up iTools accounts for new users

When you create a new user, go to the iTools
Web site to create an iTools account for the user.
Give the user the iTools member name and
password to enter in Internet preferences. Mail
will get the user’'s Mac.com email automatically.

V'}?\\ Searching Mac Help

‘\', How do | work as an
administrator?
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Use System Preferences to change your computer settings. Choose

System Preferences from the Apple menu, then click a button.

C h an g i n g Drag buttons for preferences

you use frequently to the
Click here to see toolbar, then click them to

SEttl n g S all the preferences. change the settings.

@ System Prefs Fdif View Window Help

<) ¢ = 11:23 AM
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Calarsync Displaye  Energy Saver  Keyboard Mouse

Internet & Network
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Interrer Mewwork CuickTime Sharing

System
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Updare

B BeE o

Click this icon to open
System Preferences.



Important settings panes

Desktop

Select the picture you want for the Desktop background. You can drag one to the
well or select one from the Apple Background Images collection.

Internet

Enter settings for your iTools account, email, and Web browser. You can also sign up
for your iTools account here.

Network

Enter settings to connect to your Ethernet or AirPort network or to connect to your
ISP using the internal modem. Let Mac OS X automatically select the best
connection or use a “location”—a collection of network settings.

Sharing

Turn on file sharing so that other people on the network can access your Public
folder. Turn on Web sharing to publish your personal Web site.

Software Update

Get updates to your Mac OS X applications and software. You can check for updates
immediately or select how often Software Update checks.

Screen Saver

Select a screen saver and choose whether you want to require a password to wake it.

You can use the pictures included with Mac OS X or your own pictures.

Startup Disk

Select a Mac OS 9 or Mac OS X system to start up your computer.

() For the experienced
/' Mac OS user

Where are the control panels?

Use System Preferences to change computer
settings instead of the control panels in Mac OS 9.

Changing the alert sound

Use the Sound preferences pane to select a
different alert sound and set the volume.

Setting QuickTime preferences

Use QuickTime preferences to register QuickTime
Pro and select your QuickTime connection speed.

'\\
>< Mac OS X tips

Gaining access to settings

If the settings in a pane are dimmed and the lock
icon is locked, click the icon and enter a name
and password for an administrator.

Adding items to the toolbar

To add an item to the System Preferences toolbar,
click Show All and drag the icon to the toolbar. To
remove an item, drag it from the toolbar.

Using a different language

Open International preferences and drag the
language you want to use to the top of the list. To
use a special keyboard, click Keyboard Menu and
select the appropriate item. Choose the keyboard
from the Keyboard menu (the one with the flag). To
see the Finder in the new language, log in again.

i /‘,7“ Searching Mac Help
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Connected

Mac OS X provides integrated Internet and network access, which you
set up when you set up Mac OS X. You can set up other network

connections, turn on Web and file sharing, and access network servers.

Connect to the Internet
using the AirPort or
modem icon.

Choose New Location here to name a
collection of settings. To use a location,
choose Location from the Apple menu.

) = 11:23 AM

@ System Prefs FEdit View Window Help

Selact Base Station

S 0 W

Other Rescan Configure
88 Network
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Show All Displays Sound Network Startup Dish

P = Name: Base Station
bedtlom:g Aomat s Ty Ethernet ID: 00 00 00 OC 0000
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Telephone Number:  555-3456
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Account Name:  jandoe

Password: sessss
E Save password

Checking this box allows al| users of this compurer ra
access this INTEMET ACCOUNT WIthouT eAtering a password
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(&) ciick the lock to prevent further changes.
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Use the AirPort Admin
Utility to manage your
AirPort network.

Use Network preferences to
set up each of the network
connections you use.



When you choose Connect To Server from the Go menu (in the Finder), this dialog appears.

Connect to Server

Choose a server fram the list, or enter a server address

At @Lu(a\ Network A f?
- L —————Choose arecent server from
Local Netwark @ Document Server this pop-up menu.
& Print Server
© web Server
Click a network neighborhood,
then click a server. ltems that
appear here are set up by your
system administrator.
Address —————Type the name of a server here.
( Cancel

Mac OS X lets you connect to many types of servers:
Mac OS X shared Public folders
Your iDisk (type “iDisk.mac.com”)
Web-based file sharing servers (WebDAV)
Mac OS X Servers
Any file server that supports AFP over AppleTalk or TCP/IP
Any file server that supports any Windows file source or Unix Samba server
Mac OS 9 Web sharing sites
Mac OS 9 file sharing folders over AppleTalk or TCP/IP

After you connect to a server, an icon for the server appears on the desktop and a Finder window
opens. You can also see servers when you click the Computer button in a Finder window toolbar.

() For the experienced
"/ Mac OS user

-

To connect to servers, use Connect To Server
in the Go menu instead of the Chooser or
Network Browser.

To create a location, open Network preferences
and choose New Location from the Location
pop-up menu. To select a location, choose
Location from the Apple menu.

To turn on Web sharing and file sharing,
open System Preferences and click Sharing.

AV4

lf; Mac OS X tips
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If you choose the Automatic location, Mac OS X
selects network connections for you. To change
the order in which it tries connections, open
Network preferences and choose Active Network
Ports from the Show pop-up menu, then drag the
items in the list to rearrange them.

Mac OS X lets you use several network
connections simultaneously. You can even
use several configurations for a single port.

To disconnect from a server, select it in the Finder
and choose Eject from the File menu.

*,7 a Searching Mac Help
Y¥_°4  How do I connect to
the Internet?
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From setup to email to publishing on the Web, Mac OS X makes it easy

to communicate with your friends, family, and colleagues using iTools.

iDisk
Now your iDisk is just a click away. Store movies, pictures, and documents on
your iDisk, then share them with others.

Mac.com

\\& Provides complete email service that works with your favorite email program.
Mﬂé COﬁl If you use Mail, it’s set up to use your Mac.com account.

iCards

Create personalized iCards using photos on your iDisk. Send notices to
colleagues or pictures of the kids to the folks.

—oOh HomePage
;r'n ﬁ Build a personal Web site in three easy steps. Create a photo album, publish
™ = | aniMovie, post your résumé, and share your iDisk Public folder.
=



Setting up a new iTools account

When you set up Mac OS X, you can also set up your iTools account. If you set up other users for
your computer, go to the {Tools Web site to set up iTools accounts for them, then give each user a
member name and password to enter in the iTools pane of Internet preferences. New users can
also sign up for an iTools account by clicking Free Sign Up in the iTools preferences pane.

86 Internet (==
= : ® =i

uel| || |

Show All © Displays Sound Network Startup Disk

iTools | Email Trmi\rNewsr'

Set up your iTools account

Enter your member name and password. This
information is used to access iTools, including
your iDisk and your email account.

iTools Member Name:

Passward:

Need an account?

Get the most out of the Internet with iTools. Click
Sign Up and start using iTools today.

Csign U

Click this button to sign up for
a new iTools account.

Using iDisk to share your files with others

Other iTools members who know your member name can access anything in the Public folder on
your iDisk and copy items from that folder. Only you can add or change things in the folder. If you
prefer, you can use HomePage to publish your photos, movies, and documents on your iTools Web
site so that anyone can see them, regardless of the computer they are using.

\ For the experienced
*J Mac OS user

Accessing your iDisk

Your iDisk is permanently available so you don’t
have to go to the iTools Web site to open it. Just
click the iDisk icon in a Finder window toolbar or
choose iDisk when you open or save a document.

Mac.com stores your mail

Mac.com now stores your email on the Apple
server so it’s always available and you can access
it from different computers. If you need mail when
you are offline, create a mailbox in Personal
Mailboxes and drag email to it.

X Mac OS X tips

Using Mail to get your Mac.com mail

The Mail application is set up to check your
Mac.com mail account automatically, if you enter
your member name and password in the iTools
preferences pane.

Learning more about iTools
Visit the iTools Web site and click Help to learn
more about using iTools.

itools.mac.com

i '/'9\‘\ Searching Mac Help

¥, How do I use my iDisk?
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Use Mail to send and receive email. Your email can include pictures,
sounds, and movies as well as text. And Mail is set up to check your

Mac.com mail automatically.

Drag email messages to
mailboxes in Personal Mailboxes
to save them on your hard disk.

To change the toolbar,
choose Customize Toolbar

from the View menu.

Type here to
search your
addresses.

Mail File

Edit  View Mailbox

¥ 1D Persnnal Mailboxes

B 0uthox
[ Leeal Sauff
LA Read Later

¥ § iTools:steve@mailmac.com
[SUNBOX (1 unread)
[ Drafts
7 Sent Messages
& Deleted Messages
[ 5ave

¥ (@ stevedcompany.com
Einpox
& Deleted Messages
A Admin
@ Drafts
[T keepers
(¥ Miscellaneous
¥ Project
(¥ 5chedules

GI3)

12 massagas
«  #From
@ 12 Tom Clark
11 Tem Clark
10 Jan Doe
=+ 9 Jan Doe
8 Tom Clark
7 AppleiCards

Message  Format

Subject

‘Got your message
Friday

Re: and Another Thing
That info you wanted...
Eig Mews!

Window  Help

INEOX|on (Tools stevedmail. mac.com (1 unraad)

a / =

Dclete Reply Reply Al Farward Compose Madbex G Mail

Q™ G

Search Mailbox

Date&Time T
Today at 03:468M I
Today at 04.35PM
Today at 04:44PM
Today at 05:43PM
Today at 06.42PM

Bill Jarmes has sent you an Apple iCard  Today at 06:52PM

Thia ICard has been sent to you fram Bill James

e Think differe,

Hi Steve,

Take 2 ook at my
MW COMm puter. 1sn't it
great? Did you ever
listen to those MP3s?
~Bill

<) & =[11:23 AM

B

Hard Disk

Audio CD

TEmail

relark3@mac com
jandeedmac.com
Liflllames @mac.com

Click Mailbox to Use the Address Book to
see this drawer. store information about
friends and colleagues.



Sending email
To send email, click the Compose button, type the address, and write your message.
@,@e New Message =

v & E A Q

Send Attach Address Fonts Colors Save As Draft

To change the toolbar, choose
——Customize Toolbar from the View menu.

To: Bill <billjames2@mac.com> As you type, Mail selects matching
cc addresses from your Address Book.

Subject: Press Return to continue adding

addresses or press Tab to move to

the next text box.

Listening to them now.

To add a picture, sound, or movie
to your message, drag it from the
Finder to your message.

Using the Address Book

Click New in the Address Book toolbar to add information about someone.

Mail enters this email address
when you type the person’s name

80 untitled address card in the To or Cc box of a message.
First name: Tom Email m tclark3@mac.com x | . . .
s To see a picture in email you
Last name:| Clark Work Phone 71 receive from this person, drag
- the picture here.
Categories. .. £ cancel @

For the experienced
Mac OS user

Using Mail for your email

Mail works with your Internet preferences and the
Address Book application. If your iTools member
name and password are in the iTools preferences
pane, Mail gets your Mac.com mail automatically.

Y .

\ Mac OS X tips

AL X

Setting up Mail

When you set up Mac OS X, you also set up how
to send and receive your email. Mail can check
several email accounts for you. To create other

accounts and change settings, choose Preferences
from the Mail application menu.

Setting up Mail for a new user

If you create a new user, the first time you log in as
that user and open Mail a setup dialog appears. If
you put an iTools member name and password in
the iTools preferences pane, Mail automatically
checks your Mac.com mail.

Using several Mac.com accounts

If you have several iTools accounts, Mail can check
Mac.com for each one. Choose Mac.com from the
Account Type pop-up menu when you create the
mail account.

Creating mailboxes

You can use mailboxes in Personal Mailboxes or in
an account mailbox to organize your messages. To
create a mailbox, select the account and choose
New Mailbox from the Mailbox menu.

| '/“9“ Searching Mac Help

) .
‘\, How do | send and receive
email?
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Printing

Choose Print from the File menu to print a document. If you use a USB
printer, it's already selected. Use Print Center (in the Utilities folder) to

select network printers you want to use.

Use the default printer or
choose a different printer here.
Printers and applications can Choose Edit Printer List to open
add settings to the Print sheet. Print Center.

<) & = 11:23 AM

Poster E‘

Printer: | USE Printer o
L saved sertings: | Standard = e )

[ Copies &P =
CopiesGPages ¥} Audio Co

@ Preview File Edit Display  Window

Copies. 1 W Collated

Pages: @ all
& o |1

Preview ©  Cancel * (7 Prim

Click here to see how the dooument| |Click Print Center to
will look before you print it. manage your print jobs.




Selecting printers using Print Center

Mac OS X provides built-in support for some of the most popular USB printers so that they are set
up automatically. Before you print a document to a network printer, use Print Center to add it to
the Printer List.

eoe Printer List
© [Name & Kind Status
LaserWriter Ipr host

©  Ush Printer printer This printer is the default. To change
the default printer, select a printer in
the list and choose Make Default
from the Printers menu.

add printer. '—————————(Click here to add a printer.
"6 08 Printer List
-] AppleTalk I
+ LPR Printers using IP ¥ ——————Choose the type of connection
Ust ; for the printer here.

LPR Printer

Directory Services
Internet address ol

——

T Use Default Queue on Server

Printer Model: = Generic =

I’ 5
Cancel

Creating a PDF or PostScript file

To create a PDF or PostScript file of a document, choose Print, then choose Output Options from

the pop-up menu. Select the “Save as File” checkbox, choose the format you want, then click Save.

(If PostScript is dimmed, you haven't set up a PostScript printer in Print Center.) You can also click
Preview, then save the document as a PDF from the Preview application.

)\ For the experienced
)/ Mac OS user

Where is the Chooser?

You use Print Center to select and set up printers

(instead of the Chooser). Mac OS X does not have
desktop printers because you can select a printer

right in the Print dialog.

Printing a Finder window

If you want to print a Finder window or the
Desktop, first set it up the way you want. Use
Grab to take a screenshot of the window, then
print the screenshot.

X 7
\\ .
X Mac OS X tips
Setting up a document to print

Before you print a document, choose Page Setup
from the File menu to select page options.

Managing your print jobs

When you print a document, Print Center opens.
Click its icon in the Dock to manage your print
jobs. You can stop and start the printer queue, or
hold, resume, and delete print jobs.

Printing when not connected

If you are not connected to your printer, you can
start print jobs to print later. Open Print Center
and choose Stop Queue from the Queue menu.
Then print your documents. When you are
connected to your printer, choose Start Queue
from the Queue menu.

“

G} Searching Mac Help
‘\'p How do | print my documents?
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Advice

.\-

Installing Mac OS X
You want to install Mac OS X on a different disk or disk partition.

Instead of installing Mac OS X on the same disk or disk partition as Mac OS 9, you can install it on a
different disk or disk partition.

If your disk is not partitioned, you need to reformat it. Before you do, back up your documents.
Open the Mac OS X Installer and choose Open Disk Utility from the Installer menu. Follow the
onscreen instructions to partition and format your disk, then install Mac OS X. You can install
Mac OS 9 on the other partition later.

The Installer doesn’t appear.

If you double-click Install Mac OS X and the Installer doesn’t appear, restart your computer while
holding down the C key to start up your computer using the Mac OS X CD. (For more information
about restarting your computer, see the documentation that came with it.)

If the Installer still doesn’t appear, restart your computer and press the mouse button or trackpad
button to eject the Mac OS X CD. After your computer starts up, insert the Mac OS X CD again and
use the Startup Disk control panel (Mac OS 9) or the Startup Disk preferences pane (Mac OS X) to
select the Mac OS X CD as your startup disk and restart.



If a message says you need to update your computer’s firmware, do so before you install Mac OS X.

Updaters may be available on your Mac OS X CD. You can also check the Apple software updates
Web site (asu.info.apple.com).

If this happens and Mac OS 9 is installed on your computer, restart your computer while holding
down the Option key to start up using Mac OS 9. If you cannot start up this way, insert a Mac OS 9
CD in your computer and hold down the C key while restarting your computer. Open the Startup
Disk control panel and select your hard disk with Mac OS 9 installed.

First, make sure you are typing your user name and password with the same capitalization

and punctuation that you used originally. If you still can’t log in, log in as an administrator, open
Users preferences, and change your user name or password. If you don’t know the administrator
password and you have the Mac OS X CD, start up your computer using the CD and choose
Reset Password from the Installer menu. If you don’t have the CD, contact the administrator of
your computer.

If you forget the password for your computer, insert the Mac OS X CD and restart your computer
while holding down the C key. When the Installer appears, choose Reset Password from the
Installer menu and follow the onscreen instructions.

s

Troubleshooting tips
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If a message says that the Installer cannot repair
the disk, you may need to reformat it. First, back
up your documents. Then start the installation
again, and when you select the destination disk,
click the checkbox to format it and choose Mac
OS Extended.

The Installer cannot update non-Apple hard disks.
Use the disk utility recommended by the
manufacturer to update your disk before installing
Mac OS X. Make sure to use a version of the utility
that is compatible with Mac OS X.

If you can’t log in to your Netinfo account, you can
log in to your computer as the local user
“Administrator,” with your Netinfo password.

1? « Searching Mac Help
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Advice

Using Mac 0OS X
Network services don’t seem to be working.

Make sure your computer is connected to the network and that your network settings are correct
in System Preferences. See your system administrator to make sure the service is available or if you
have questions about the settings you should use.

You can’t quit an application.
If you can’t quit an application, choose Force Quit from the Apple menu, select the application in
the list, and click Force Quit. (You do not need to restart your computer.)

Important When you force an application to quit, any unsaved changes to documents open in that
application are lost.

The Finder doesn’t seem to be working.

If the Finder doesn’t seem to be working, choose Force Quit from the Apple menu and select the
Finder, then click Relaunch. The Finder will restart. You do not need to restart your computer. Your
applications will remain open and you will not lose any changes to your documents.



To start up using Mac OS 9, open System Preferences and click Startup Disk. Select a
Mac OS 9 system disk and restart your computer.

e e Startup Disk =
« W4 =3
Show All  Displays 5Sound Network Startup Disk

Select the System Folder to use for starting up your computer.

Select the Mac OS 9

Mac 05 X, 10.1 Mac 05 5.2 system you want to use.
on Hard Disk on Hard Disk

You have selected Mac OS 9.2 on the volume Hard Disk

&) Click the lock to prevent further changes. “Restart |

If you start up your computer in Mac OS 9 and then want to start up in Mac OS X, use the Startup
Disk control panel to select your Mac OS X disk. Use the Startup Disk control panel on the
Mac OS X CD or a later version if it’s available. To install the control panel, drag it to the System

Folder on your Mac OS 9 disk.

If necessary, click this triangle to
see the systems you can choose.

O Startup Disk =)=

Sg¢lectthe Mac 05 system folder to start up your computer:

Marne Yersion
=+ = Hard Disk Pac 05 9.2.1
i) Hard Disk System Folder Mec 05 9.2.1
fard stem Mac 03 % 10.1 Select the Mac OS X
system you want to use.
Restart
3

Click Restart to
start up in Mac OS X.

\/
>\ Troubleshooting tips
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For information about the support available for this
product, see the Apple Software Services and
Support Guide included with Mac OS X.

To search for solutions to problems you have with
Mac OS X, choose Help from the Help menu, type
a question, and click Ask.

To get the latest information about Mac OS X,
Mac OS X applications, and Classic applications,
open Mac Help and click More under News.
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